ghipsmall

Chipsmall Limited consists of a professional team with an average of over 10 year of expertise in the distribution
of electronic components. Based in Hongkong, we have already established firm and mutual-benefit business
relationships with customers from,Europe,America and south Asia,supplying obsolete and hard-to-find components
to meet their specific needs.

With the principle of “Quality Parts,Customers Priority,Honest Operation,and Considerate Service”,our business
mainly focus on the distribution of electronic components. Line cards we deal with include
Microchip,ALPS,ROHM, Xilinx,Pulse,ON,Everlight and Freescale. Main products comprise
IC,Modules,Potentiometer,IC Socket,Relay,Connector.Our parts cover such applications as commercial,industrial,
and automotives areas.

We are looking forward to setting up business relationship with you and hope to provide you with the best service
and solution. Let us make a better world for our industry!

Contact us

Tel: +86-755-8981 8866 Fax: +86-755-8427 6832
Email & Skype: info@chipsmall.com Web: www.chipsmall.com
Address: A1208, Overseas Decoration Building, #122 Zhenhua RD., Futian, Shenzhen, China

iy [0



PRODUCT MANUAL

MiniCom (OP6800)

C-Programmable Operator Interface

User’s Manual
019-0106 -+ 090529-G



MiniCom (OP6800) User’s Manual

Part Number 019-0106 ¢ 090529-G e Printed in U.S.A.
©2002-2009 Digi International Inc. * All rights reserved.

No part of the contents of this manual may be reproduced or transmitted in any form or by any means
without the express written permission of Digi International.

Permission is granted to make one or more copies as long as the copyright page contained therein is
included. These copies of the manuals may not be let or sold for any reason without the express written
permission of Digi International.

Digi International reserves the right to make changes and
improvements to its products without providing notice.

Trademarks

Rabbit and Dynamic C are registered trademarks of Digi International Inc.

Rabbit 2000 and RabbitCore are trademarks of Digi International Inc.

The latest revision of this manual is available on the Rabbit Web site, www.rabbit.com,
for free, unregistered download.

Digi International Inc.

www.rabbit.com

MiniCom (OP6800)



TABLE OF CONTENTS

Chapter 1. Introduction 1
1.1 DIESCIIPLION ...ttt ettt ettt ae e sae e e a e et e sae e e besanesa e eanesn e e e enneene 1
1.2 FRALUTES ...ttt ettt et st e b e et e s bt e e a bt e bt e eat e e sbeesabe s bt e bt e she e e ebeesate s bt enaeeats 1
1.3 Development and Evaluation TOOIS..........c.cocuiiiiiiiiiiiiieicice et 2

130T TOOL Kit ottt ettt et ettt a et sttt et ebeebe et ensenie 2
132 SOTEWATE ..ttt ettt et b e bt bt sa e et e bt et e s bt e bt e s bt ebee st e ea b et e et e b enee 3
1.4 CE COMPLIAIICE ..c.venetieniiiieeteeiteieete sttt ettt st ettt ettt s et et e bt ebt e s bt sat e saeeabenbe et enbeebeenbesbeeneesbeene 4
1.4.1 DeSign GUIEIINES ....c..cccueruieiiiiiiiiieeieteetet ettt ettt ettt ettt sttt e b ettt sate b e et e e enee 5
1.4.2 Interfacing the OP6800 to Other DEVICES ......ccouiiiiiiiriiiiiiiieeieereeeeeeete et 5

Chapter 2. Getting Started 7
2.1 COMMECTIONS ...euvitiuieiiteeitietteete et e et e it e st ebte e bt e bt e sabeeabeesbteesbeesatesabtessbeeabeesateenbeenstesabeesseesnseesasesasaense 7
2.2 Demonstration Program on POWEer-Up .........ccccccooiiiiiiiiniiniiicee et 10
2.3 Display Contrast AQJUSIIMENT..........cccueouieieriiiienieiitt ettt et seeesr e bt et eas e aesaeesaeennes 10
2.4 Programming Cable CONMECTIONS .......eevueerurirriierieinieenieeiteniteeteesteestte st e sbeeeateesteesabesbeesseeenbeenseenaees 11
2.5 Installing DynamiC C ........ocoooiiiiiiiieicieee ettt et et e e s 12
2.6 Starting DyNamiC € ......cc.ooiiiiiiiiiiieceee ettt e et e saeeanes 12
2.7 PONGLC ..ottt sttt sttt ettt es bt e bt sa e b bt se et ea b et e bt eneebeebenaea 13
2.8 Where Do I GO From HEIE? .....cocueiiiiiiiiiiieiei ettt sttt st et 13

Chapter 3. Subsystems 15
31 PINOULS ettt ettt eat et sttt et bbbt a e bt et bt e bt eheeat e sbe et sae et b e e benbaens 16
3.2 DHGIAL IO ittt ettt e bbbttt ettt et s he bt bttt st et b e be b ens 17

3.2.1 DIl INPULS.c..eouiiiiiiiiiiiiterteeit ettt ettt bt et sat et sbe e b e st et b e b nbeens 17
3.2.2 DiIGItAl OULPULS ...ueenteeiieriieiteiteeiteteet ettt sttt et ettt et s beebt e s bt et e sbeest e bt esbesbeeseesbeestesaeenbenbeenbenbaens 18
3.3 Serial COMMUNICATION ...verutiiriieirieeriieeieett et et ete et et e e st e e st e st te s bt e eabeesbeesabeesstesateenbeesatesbeesnsenaneens 19
331 RS-232 ettt b et b e sttt st a et ettt ebe et be e 19
332 R S8 ettt h et bbbttt sh et st e b e e b nbeens 19
3.3.3 Programming POIT.......c.ccociiiiiiiiiiiiieeieeteeetee ettt ettt sttt et 21
3.3.4 Ethernet Port (OP6800 MOdelSs ONLY) ....cocueeuiiiiiiiiiniieiieie ettt e 22
3.4 Programming CabIe ........c..cooiriiiriiiiiiieeeieeteset sttt ettt et sttt st a e eae e e e 23
3.4.1 Changing Between Program Mode and Run Mode .........c.cooevierieninieniiniineieneenienieeeeeees 23
3.5 Other HardWAre. .......cooiiiiiiiiiiieiieniitest ettt ettt et st ettt st et be et sbe et e sbeesaesaeennens 24
3.5.1 CIOCK DOUDIET .....cuiiiiniiitiieeitcteet ettt ettt ettt et ettt et e e et be e benbeens 24
3.5.2 SPECIUM SPIEAET ....ceouveiiiiriiiieiieete ettt ettt ettt et e sb e e beebte st e et e sbee e bt e sabeeabeenbeesaeesabes 25
B0 IVICTIIONY ...ttt ettt ettt eat ettt st e et bt e b s bt bt s bt et e st e b e bt e bt eat et sb e e bt sae et b e e benbaens 26
3.0.1 SRAM ...ttt ettt sttt et h e a bbbt et b et bt et benbeen 26
3.6.2 FLaSh IMEIMOTY ...veiuiiiiiiiiiiirteeiteiteeit et ettt ettt ettt e sb ettt s bt ebeesbeeste st enbenbeenaenbeens 26
3.7 Keypad LabELIING ......cocooiiiiiiiiiieiieeie ettt ettt s e s st e 27
Chapter 4. Software 29
4.1 Upgrading DYNAMIC € ...c.oouiiriiiiiiiiinieieteeeetcete ettt ettt ettt ettt et e st b e besbeeatesanenteeae 31
4.1.1 Patches and BUZ FIXES .....co.uiiiiiiiiiiiiniiieneee ettt sttt et 31
A 1.2 UPGLAAES ..ottt ettt ettt et et ettt e b e e st e s bt e s bt e bt e shee e bt e sabesab e e bt e e naeesabeebeenaeen 31
4.2 Font and Bitmap CONVETTET..........cc.iiiiiiiiiereiieite ettt ettt ettt st s e seeeaneneenne 32

User’s Manual



4.3 Sample ProOZrams........ccccooiiriiiiiiieieiecee ettt ettt st st 33

4.3.1 BOAIA ID ..ttt ettt ettt benee 33
4.3.2 Demonstration BOArd.........coc.uiiiiiiiiiiiiieieeeteee ettt s 33

4.3.3 DAl IO ..ottt ettt 34

4.3.4 Serial COMMUNICALION ...eeuvtiruiiriieriieerteeeie et te st etee st e et e sttt st e e sttesteesbbesabeenbeesateesseesabesbeesaesnses 34

4.3.5 LCD/Keypad Module Sample Programs.............cccccocieiiiiiniiniinieieieeeneeeceeeieseesee e 34

4.3.6 TCP/IP SamPle PrOGIams.....c..ccoverieriiriinieiieieetenieeitesieste sttt ettt se et sbe et e e naesbeenaenieeas 35

4.4 OPOBO0 LIDIATIES ...cuveuveeeureieiietieiietentcntesterte sttt et ettt st et sbe et sbt st besaesa st e b et eaeneebebesbenenbenee 36
Chapter 5. Using the TCP/IP Features 37
5.1 TCP/IP CONNECHIONS ....cveuviieiierieieteiteiteitete ettt sttt ettt s b sae st sa s e st easeaeebesuesaeenes 37
5.2 TCP/IP Sample PrOrams. ........coueeiireeiiniiieieeteieeniesttent ettt et ettt et st e sttt saee b ebee st eeaeenaeenee 39
5.2.1 How to Set IP Addresses in the Sample Programs...........cccccecceveriniinieniinenienineeencenencee. 39

5.2.2 How to Set Up Your Computer for Direct CONNECT .........cocereereririereinieniienienieneeeieieeee e 40

5.2.3 Run the PINGME.C DEIMO........ccccuiiiiiiiieiiiieciiteeieesseeesieeeeeeessseeeessaeesesseeessseessssseesssseessseens 41

5.2.4 Running More Demo Programs With a Direct COnnection ...........ccoccevereeuenennieneeneneenennnenn 41

5.2.5 LCD/Keypad Sample Programs Showing TCP/IP Features ..........ccccceceevereenenieiienensieneenienne 42

5.3 Where Do I GO From HETEY ......cocuuiiiiiiiiiiiiieeieeetet ettt ettt sttt 43
Chapter 6. Installation and Mounting Guidelines 45
6.1 Installation GUIAEIINES. .......c.ccuerieiiiiiiiiiieiie ettt sttt st 45
6.2 MoUNTING INSTIUCTIONS ...cuviiuietieiiiiiiie ittt ettt ettt sttt e e e st ebtesbe et sbeeb et eaeenaeenee 46
6.2.1 Bezel-Mount Installation ........cccoevuiiuiriiriiciinieiciieictccce et 46
Appendix A. Specifications 49
A.1 Electrical and Mechanical SpecifiCations.........c..cocuereiierienieiieieiieeeereeee e 50
A2 Conformal COAINE .......ccieeiiriiiiiiieie ettt ettt et st e et s e sanesn e e e s e et eneenee 53
A3 Jumper CONFIGUIALIONS ........oouieieiiiiiieiieieetete ettt et esee st st st e be e e n e s sn e et e neenee 54
A.4 Use of Rabbit 2000 Paralle]l POILS ......c.c.ccoiiiiiiiiiiiiiiente ettt st s 55
A5 T/O Address ASSIZNIMENTS........cceoieiuirrieiiriieienieeteeieee ettt ere st esee st eae st enesreeesesae e e e seesneeaeeneenee 57
Appendix B. Power Supply 59
Bl POWET SUPPLIES ..ottt et st e sttt e bt bt e bt s bt e st eb et eaeenaeenee 59
B.2 Batteries and External Battery CONNECHIONS ........ccueeueriierientiriineeieeieenie sttt sttt nie et s sreeae v 60
B.2.1 Battery-Backup CiICUIl.......cccotireriiiierieieeiteniteitesie ettt sttt st e 60
B.2.2 Power t0 VRAM SWiILCH ...cuuiiiiiiiiiiieie ettt sttt s s 61
B.2.3 RESEE GENETALOL.......cueeuiiiiiiiictiicie sttt sttt et sa e s sttt sa e nenis 61

B.3 Chip SElECt CICUIL......eiueiiiiiiieieieiieieeitetee ettt sttt et s ea e sae s 62
Appendix C. Demonstration Board 63
C.1 Mechanical Dimensions and Layout ...........ccoccoieiiiiiiiiiiiiiniiiie et 64
C.2 POWET SUPPLY ..ttt ettt et st a e st st neeae e e esae e enie 65
C.3 Using the Demonstration BOArd ............c..cocooiiiiiiiiiiiiiiiiiece e 67
Appendix D. OP6800 Function Calls 71
D.1 Board Initialization (OPOSXX.LIB).........ccoiiiiiiiieiii ettt ettt e e e stve e e etveaeeens 72
D.2 Digital I/O (OPO8XX.LIB) ...c.cooveiiiiiiiiiiieiiiictieiie sttt sttt ettt ea e s s 73
D.3 Serial Communication (OPOSXX.LLIB)........ccoiiiiiiiiiiiiiiicciie ettt ettt e e eve e e evaeeeens 74
D.4 LEDS (OPOSXX.LIB) ....oouiiiiiiiiiiiiiiie ittt st sttt en e s 76
D.5 LCD DiSPIAY...cuteutertieiinieeieettete sttt ettt ettt ettt et st saesbe et s bt et eb e ettt et ea et eaee b ene 77
D51 KEYPAA. ..ttt ettt sttt et et eb e bt ettt sttt et e b enee 97
Index 101
Schematics 105

MiniCom (OP6800)



1. INTRODUCTION

The OP6800 intelligent terminal interface is a small, high-
performance, C-programmable terminal interface that offers
built-in I/O and Ethernet connectivity. A Rabbit® 2000 micro-
processor operating at 22.1 MHz provides fast data processing.

1.1 Description

The OP6800 intelligent terminal interface incorporates the powerful Rabbit 2000 micro-
processor, flash memory, static RAM, digital I/O ports, RS-232/RS-485 serial ports, and a
10Base-T Ethernet port.

1.2 Features

122 x 32 graphic display.
7-key keypad.
7 LEDs.

24 digital I/O: 13 filtered digital inputs, and 11 sinking high-current outputs (7 outputs
with LED indicators, and 4 high-current digital outputs with transient protection to
drive inductive loads).

Rabbit 2000 microprocessor operating at 22.1 MHz.

128K static RAM and 256K flash memory standard, may be increased to 512K SRAM
and 512K flash memory.

One RJ-45 Ethernet port compliant with IEEE 802.3 standard for 10Base-T Ethernet
protocol (OP6800 only).

Four serial ports (2 RS-232 or 1 RS-232 with RTS/CTS, 1 RS-485, and 1 CMOS-com-
patible programming port).

Battery-backable real-time clock, connection point for external battery included.
Watchdog.

Reset generator.

Meets NEMA 4 watertightness specifications when front-panel mounted.

Remote program downloading and debugging capability via RabbitLink.
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Two OP6800 models are available. Their standard features are summarized in Table 1.

Table 1. OP6800 Models

Feature OP6800 OP6810
Microprocessor Rabbit 2000 running at 22.1 MHz
Static RAM 128K
Flash Memory 256K
RJ-45 Ethernet Connector and

. . Yes No
Filter Capacitors
RabbitCore Module Used RCM2200 RCM2300

One additional 512K flash/512K SRAM memory option is available for custom orders,
and involves nominal lead times. Contact your Rabbit sales representative or authorized
distributor for more information.

Throughout this manual, the term OP6800 refers to the complete series of OP6800 opera-
tor interfaces unless other production models are referred to specifically.

Appendix A provides detailed specifications.

Visit our Web site for up-to-date information about additional add-ons and features as
they become available. The Web site also has the latest revision of this user’s manual.

1.3 Development and Evaluation Tools
1.3.1 Tool Kit

A Tool Kit contains the hardware essentials you will need to use your OP6800. The items
in the Tool Kit and their use are as follows.

e Dynamic C CD-ROM, with complete product documentation on disk.
e OP6800 Getting Started instructions.
e Programming cable, used to connect your PC serial port to the OP6800.

e Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z.,
U.K., and European style plugs).

e Demonstration Board with prototyping area, pushbutton switches, and LEDs. The
Demonstration Board can be hooked up to the OP6800 to demonstrate the I/0O, and the
prototyping area can be used for custom circuits.

e Ribbon cable to connect Demonstration Board to OP6800.
e Screwdriver.
e Rabbit 2000 Processor Easy Reference poster.

e Registration card.

2 MiniCom (OP6800)
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MiniCom (OP6800)

Ribbon Cable Screwdriver

Getting Started
Instructions

Demonstration Board

Figure 1. OP6800 Tool Kit

1.3.2 Software

The OP6800 is programmed using version 7.06 or later of Rabbit’s Dynamic C. A compat-
ible version is included on the Tool Kit CD-ROM. Library functions provide an easy-to-use
interface for the OP6800. Software drivers for the display and keypad, TCP/IP, I/O, and
serial communication are included with Dynamic C.

Dynamic C v. 9.60 includes the popular uC/OS-II real-time operating system, point-to-
point protocol (PPP), FAT file system, RabbitWeb, and other select libraries that were pre-
viously sold as individual Dynamic C modules.

Rabbit also offers for purchase the Rabbit Embedded Security Pack featuring the Secure
Sockets Layer (SSL) and a specific Advanced Encryption Standard (AES) library. In addi-
tion to the Web-based technical support included at no extra charge, a one-year telephone-
based technical support subscription is also available for purchase. Visit our Web site at
www.rabbit.com for further information and complete documentation, or contact your
Rabbit sales representative or authorized distributor.
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1.4 CE Compliance

Equipment is generally divided into two classes.

CLASS A CLASS B

Digital equipment meant for light industrial use Digital equipment meant for home use

Less restrictive emissions requirement:
less than 40 dB pV/m at 10 m
(40 dB relative to 1 pV/m) or 300 uV/m

More restrictive emissions requirement:
30dB uV/m at 10 m or 100 pV/m

These limits apply over the range of 30-230 MHz. The limits are 7 dB higher for frequencies
above 230 MHz. Although the test range goes to 1 GHz, the emissions from Rabbit-based
systems at frequencies above 300 MHz are generally well below background noise levels.

The OP6800 has been tested and was found to be in conformity with
the following applicable immunity and emission standards. The OP6810
is also CE qualified as it is a sub-version of the OP6800. Boards that
are CE-compliant have the CE mark.

NOTE: Earlier versions of the OP6800 sold before 2003 that do not
have the CE mark are not CE-complaint.

Immunity

The OP6800 operator interfaces meet the following EN55024/1998 immunity standards.
e EN61000-4-2 (ESD)

e EN61000-4-3 (Radiated Immunity)

e EN61000-4-4 (EFT)

e EN61000-4-6 (Conducted Immunity)

Additional shielding or filtering may be required for a heavy industrial environment.
Emissions

The OP6800 operator interfaces meet the following emission standards emission stan-
dards with the Rabbit 2000 spectrum spreader turned on and set to the normal mode. The
spectrum spreader is only available with Rev. C or higher of the Rabbit 2000 microproces-
sor. This microprocessor is used on the OP6800 operator control panels that carry the CE
mark.

e EN55022:1998 Class B
e FCC Part 15 Class B

Your results may vary, depending on your application, so additional shielding or filtering
may be needed to maintain the Class B emission qualification.
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1.4.1 Design Guidelines

Note the following requirements for incorporating the OP6800 operator interfaces into
your application to comply with CE requirements.

General

The power supply provided with the Tool Kit is for development purposes only. It is the
customer’s responsibility to provide a CE-compliant power supply for the end-product
application.

When connecting the OP6800 to outdoor cables, the customer is responsible for provid-
ing CE-approved surge/lightning protection.

Rabbit recommends placing digital I/O or analog cables that are 3 m or longer in a
metal conduit to assist in maintaining CE compliance and to conform to good cable
design practices. Rabbit also recommends using properly shielded I/O cables in noisy
electromagnetic environments.

While the OP6800 meets the EN61000-4-2 (ESD) requirements in that it can withstand
contact discharges of + 4 kV and air discharges of + 8 kV, it is the responsibility of the
end-user to use proper ESD precautions to prevent ESD damage when installing or ser-
vicing the OP6800.

Safety

For personal safety, all inputs and outputs to and from the OP6800 must not be con-
nected to voltages exceeding SELV levels (42.4 V AC peak, or 60 V DC). Damage to
the Rabbit 2000 microprocessor may result if voltages outside the design range of 0 V
to 40 V DC are applied directly to any of its digital inputs.

The lithium backup battery circuit on the OP6800 has been designed to protect the bat-
tery from hazardous conditions such as reverse charging and excessive current flows.
Do not disable the safety features of the design.

1.4.2 Interfacing the OP6800 to Other Devices

Since the OP6800 operator control panels are designed to be connected to other devices,
good EMC practices should be followed to ensure compliance. CE compliance is ulti-
mately the responsibility of the integrator. Additional information, tips, and technical
assistance are available from your authorized Rabbit distributor, and are also available on
our Web site at www.rabbit.com.
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2. GETTING STARTED

Chapter 2 explains how to connect the programming cable and
power supply to the OP6800. Once you run a sample program to
demonstrate that you have connected everything correctly, you
will be ready to go on and finish developing your system.

2.1 Connections

1. Screw in the four standoffs included with the Tool Kit into the four mounting threads
on the OP6800 as shown in Figure 2.

Figure 2. Screw In Standoffs Into OP6800 Mounting Threads
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2. Connect the OP6800 to the Demonstration Board from the Tool Kit using the ribbon
cable connector as shown in Figure 3. First, connect the ribbon cable to header J1 on
the OP6800, then turn the OP6800 over and connect the other end of the ribbon cable to
header J1 on the Demonstration Board. By connecting the boards this way, you have
the option of placing the Demonstration Board behind your OP6800 in your final instal-
lation as explained in Appendix C.

N

Figure 3. Connect the OP6800 to the Demonstration Board
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3. Connect the power supply.

First, prepare the AC adapter for the country where it will be used by selecting the plug.
The OP6800 Tool Kit presently includes Canada/Japan/U.S., Australia/N.Z., U.K., and
European style plugs. Snap in the top of the plug assembly into the slot at the top of the
AC adapter as shown in Figure 4, then press down on the spring-loaded clip below the
plug assembly to allow the plug assembly to click into place.

Connect the bare ends of the power supply to the +RAW and GND positions on screw ter-
minal header J5 of the Demonstration Board as shown in Figure 4.

== E 1 F ; ]

|®®®®®@®@kﬂ®®®®®@\®e®@®@h

1066660600000, [F000C00000000000R]
1

= :10000)

-

@ Remove slot cover, OLL® red

i i 1

> insert tab into slot Heat-Shrink
Assemble Tubing

Ly% AC Adapter
/ @ Snap plug into place \E

Figure 4. Power Supply Connections

NOTE: The OP6800 itself has reverse polarity protection, but the Demonstration Board
does not. Be careful to connect the positive and negative leads as shown to avoid damag-
ing the Demonstration Board.

NOTE: If you are using your own power supply, Rabbit recommends usinga 9 V to 25 V
DC power supply. The linear regulator on the Demonstration Board can handle up to
35 V, but can get extremely hot.

4. Apply power.
Plug in the AC adapter.

CAUTION: Unplug the power supply while you make or otherwise work with the connections
to the headers. This will protect your OP6800 from inadvertent shorts or power spikes.

NOTE: A hardware RESET is done by unplugging the AC adapter, then plugging it back in.
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2.2 Demonstration Program on Power-Up

A repeating sequence of graphics and messages in various languages will be displayed on
the LCD, and the LEDs will flash on and off in sequence when power is first applied to the
OP6800. Try pressing the buttons on the keypad. The LED immediately above that button
will light up, and if you pressed one of the keys in the top row of the keypad, the corre-
sponding LED on the Demonstration Board will light up. Similarly, if you press one of the
switches on the Demonstration Board, the corresponding LED on the Demonstration
Board and on the OP6800 will light up.

Note that the programming cable does not have to be connected for this demonstration.

This demonstration will be replaced by a new program when the programming cable is
attached and the new program is compiled and run. The demonstration is available for
future reference in the Dynamic C SAMPLES\LCD KEYPAD\122x32 1x7 directory as
FUN.C.

2.3 Display Contrast Adjustment

The LCD contrast is preset at the factory. If you need to adjust the contrast for optimum
display of graphics and messages, you may adjust the potentiometer at R4 located as
shown in Figure 5. Note that OP6800 units sold before 2004 did not have any provision to
adjust the contrast.

Contrast
Adjustment

Figure 5. LCD Contrast Adjustment
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2.4 Programming Cable Connections

1. Connect the programming cable to download programs from your PC and to program
and debug the OP6800.

Connect the 10-pin PROG connector of the programming cable to header J1 on the
OP6800 RabbitCore module. Ensure that the colored edge lines up with pin 1 as shown.
(Do not use the DIAG connector, which is used for a nonprogramming serial connection.)
Connect the other end of the programming cable to a COM port on your PC. Make a note
of the port to which you connect the cable, as Dynamic C will need to have this parameter
configured. Note that COM1 on the PC is the default COM port used by Dynamic C.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use an
RS-232/USB converter (Part No. 20-151-0178) with the programming cable supplied
with the OP6800 Tool Kit. Note that not all RS-232/USB converters work with

Dynamic C.
Colored edge —> Red
Programming Cable shrink wrap
NOTE: Never disconnect the programming cable To
by pulling on the ribbon cable. Carefully pull on PC COM port
the connector to remove it from the header.

Figure 6. Programming Cable Connections

NOTE: Be sure to use the programming cable (Part No. 101-0513) supplied with the
OP6800 Tool Kit—the programming cable has red shrink wrap around the RS-232 con-
verter section located in the middle of the cable. Programming cables from other Rabbit
kits are not designed to work with the OP6800.

2. Reset the OP6800 by unplugging the AC adapter, then plugging it back in. The OP6800
is now ready to be used.
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2.5 Installing Dynamic C

If you have not yet installed Dynamic C version 7.06P2 (or a later version), do so now by
inserting the Dynamic C CD in your PC’s CD-ROM drive. The CD will auto-install unless
you have disabled auto-install on your PC.

If the CD does not auto-install, click Start > Run from the Windows Start button and
browse for the Dynamic C setup . exe file on your CD drive. Click OK to begin the
installation once you have selected the setup . exe file.

The Dynamic C User’s Manual provides detailed instructions for the installation of
Dynamic C and any future upgrades.

NOTE: If you have an earlier version of Dynamic C already installed, the default instal-
lation of the later version will be in a different folder, and a separate icon will appear on
your desktop.

2.6 Starting Dynamic C

Once the OP6800 is connected to your PC and to a power source, start Dynamic C by dou-
ble-clicking on the Dynamic C icon on your desktop or in your Start menu.

If you are using a USB port to connect your computer to the OP6800, choose Options >
Project Options and select “Use USB to Serial Converter.” Click OK.

Dynamic C assumes, by default, that you are using serial port COM1 on your PC. If you
are using COM1, then Dynamic C should detect the OP6800 and go through a sequence of
steps to cold-boot the OP6800 and to compile the BIOS. If the error message ‘“Rabbit Pro-
cessor Not Detected” appears, you have probably connected to a different PC serial port
such as COM2, COM3, or COM4. You can change the serial port used by Dynamic C with
the OPTIONS menu, then try to get Dynamic C to recognize the OP6800 by selecting
Reset Target/Compile BIOS on the Compile menu. Try the different COM ports in the
OPTIONS menu until you find the one you are connected to. If you still can’t get Dynamic
C to recognize the target on any port, then the hookup may be wrong or the COM port
might not working on your PC.

If you receive the “BIOS successfully compiled ...” message after pressing <Ctrl-Y> or
starting Dynamic C, and this message is followed by a communications error message, it
is possible that your PC cannot handle the 115,200 bps baud rate. Try changing the baud
rate to 57,600 bps as follows.

e [ocate the Serial Options dialog in the Dynamic C Options > Project Options >
Communications menu. Change the baud rate to 57,600 bps.
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2.7 PONG.C

You are now ready to test your programming connections by running a sample program.

Find the file PONG. ¢, which is in the Dynamic C sAMPLES folder. To run the program,
open it with the File menu (if it is not still open), compile it using the Compile menu, and
then run it by selecting Run in the Run menu. The STDIO window will open and will dis-
play a small square bouncing around in a box.

This program shows that the CPU is working. The sample program described in
Section 5.2.3, “Run the PINGME.C Demo,” tests the TCP/IP portion of the board (if you
have the OP6800 model—the OP6810 does not have an Ethernet capability).

2.8 Where Do | Go From Here?

NOTE: If you purchased your OP6800 through a distributor or Rabbit partner, contact
the distributor or partner first for technical support.

If there are any problems at this point:
e Use the Dynamic C Help menu to get further assistance with Dynamic C.

e Check the Rabbit Technical Bulletin Board and forums at www.rabbit.com/support/bb/
and at www.rabbit.com/forums/.

e Use the Technical Support e-mail form at www.rabbit.com/support/.

If the sample program ran fine, you are now ready to go on to explore other OP6800 fea-
tures and develop your own applications.

The following sample programs illustrate the features and operation of the OP6800.

OP6800 Demonstration Board
(SAMPLES\LCD_KEYPAD\ 122x3 2_1x7) (SAMPLES \OP6800 \DEMO_BD)
KEYBASIC.C KEYPAD.C
KEYMENU.C SWITCHES.C
SCROLLING.C
TEXT.C

These sample programs can be used as templates for applications you may wish to
develop.

Chapter 3, “Subsystems,” provides a description of the OP6800’s features, Chapter 4,
“Software,” describes the Dynamic C software libraries and describes the sample pro-
grams, and Chapter 5, “Using the TCP/IP Features,” explains the TCP/IP features and
describes some sample programs.
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3. SUBSYSTEMS

Chapter 3 describes the principal subsystems for the OP6800.

* Digital I/0
¢ Serial Communication

* Memory

Figure 7 shows these Rabbit-based subsystems designed into the OP6800.

SRAM RABBIT® —
FI 2000 Decoder Digital
ash Input
Ethernet ..
(OP6800 only) Display OD:ﬂgzlt
RabbitCore Module

Figure 7. OP6800 Subsystems
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3.1 Pinouts

Figure 8 shows the OP6800 pinouts.
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Figure 8. OP6800 Pinouts

Header J1 is a standard 2 x 20 header with a nominal 0.1" pitch. The OP6800 also has an

RJ-45 Ethernet jack on the RabbitCore module.
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3.2 Digital I/0
3.2.1 Digital Inputs

The OP6800 has eight digital inputs, INOO-INO7, each with a current-limiting resistor of
27 k€ and protected over a range of —36 V to +36 V. The inputs are all pulled up to +5 V
as shown in Figure 9.

Vce
IN
—— 0 A "
i Rabbit® 2000
I Microprocessor
GND =
GND —0——@—_|_

Figure 9. OP6800 Digital Inputs
The OP6800 also has five digital inputs, INO8—IN12, each with a current-limiting resistor
of 12 k€, protected over a range of —25 V to +25 V, and pulled up to +5 V.

The actual switching threshold for INOO-IN12 is approximately 2.40 V. Anything below
this value is a logic 0, and anything above is a logic 1.

IN13-IN17 are connected in parallel with five of the keypad buttons. These inputs are nor-
mally pulled up, but pulling one of these inputs down is the equivalent of pressing the cor-
responding keypad key remotely.

Table 2. Remote Keypad Operation

Ceypa ey | PgmeleKovpa
0(«) IN13
1(a) IN14
2(w) INI5
3(p) IN16
6(e) IN17

NOTE: Remote keypad signal inputs IN13-IN17 are not protected, and can only
handle a voltage range from 0 to +5 V. These inputs were designed solely to
facilitate a remote keypad, and should not be used for other purposes.
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3.2.2 Digital Outputs

The OP6800 has 11 digital outputs, OUTO0—OUT10, which can each sink up to 200 mA.
Figure 10 shows a wiring diagram for using the digital outputs.

OUTO00-OUTO06 can switch up to 40 V and the corresponding LEDs when the outputs are
on. OUTO07-OUT10 offer protection for inductive loads when K is connected to an exter-
nal power supply; OUT07-OUT10 are not connected to the LEDs.

OouT00-0UTO06

Vce

LOAD

4 External
Power
= Supply
4/ oéT_ (0-40V)
GND
t %
ouT07-0UT10
K
%,
l LOAD
+ External
ouT Power

' ' % = Supply
l (0-40V)
E A T

GND

Figure 10. OP6800 Digital Outputs

It is possible to use an external open-collector driver to control the LEDs associated with
OUTO00-OUTO06. Connect the external driver to the output corresponding to the LED you
wish to control, but keep the internal driver turned off. The external driver will then con-
trol the LED.
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3.3 Serial Communication

The OP6800 has two RS-232 serial ports, which can be configured as one RS-232 serial
channel (with RTS/CTS) or as two RS-232 (3-wire) channels using the serMode software
function call. Table 3 summarizes the options.

Table 3. Serial Communication Configurations

Serial Port
Mode
B C D
0 RS-232, 3-wire RS-232, 3-wire RS-485
1 RS-232, 5-wire CTS/RTS RS-485

The OP6800 also has one RS-485 serial channel and one CMOS serial channel. The
CMOS serial channel serves as the programming port.

All four serial ports operate in an asynchronous mode. An asynchronous port can handle 7
or 8 data bits. A 9th bit address scheme, where an additional bit is sent to mark the first byte
of a message, is also supported. Serial Port A, the CMOS programming port, can be oper-
ated alternately in the clocked serial mode. In this mode, a clock line synchronously clocks
the data in or out. Either of the two communicating devices can supply the clock. The
OP6800 boards typically use all four ports in the asynchronous serial mode. Serial Ports B
and C are used for RS-232 communication, and Serial Port D is used for RS-485 commu-
nication. The OP6800 uses an 11.0592 MHz crystal, which is doubled to 22.1184 MHz. At
this frequency, the OP6800 supports standard asynchronous baud rates up to a maximum
of 230,400 bps.

3.3.1 RS-232

The OP6800 RS-232 serial communication is supported by an RS-232 transceiver. This
transceiver provides the voltage output, slew rate, and input voltage immunity required to
meet the RS-232 serial communication protocol. Basically, the chip translates the Rabbit
2000’s CMOS/TTL signals to RS-232 signal levels. Note that the polarity is reversed by
an RS-232 circuit so that a +5 V input becomes approximately -10 V and 0 V is output as
+10 V. The RS-232 transceiver also provides the proper line loading for reliable commu-
nication.

RS-232 can be used effectively at the OP6800’s maximum baud rate for distances of up to
15 m.

3.3.2 RS-485

The OP6800 has one RS-485 serial channel, which is connected to the Rabbit 2000 Serial
Port D through an RS-485 transceiver. The half-duplex communication uses the Rabbit
2000’s PB6 pin to control the transmit enable on the communication line.

The OP6800 can be used in an RS-485 multidrop network. Connect the 485+ to 485+ and
485— to 485— using single twisted-pair wires (nonstranded, tinned) as shown in Figure 11.
Note that a common ground is recommended.
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Figure 11. OP6800 Multidrop Network

The OP6800 comes with a 220 € termination resistor and two 681 €2 bias resistors
installed and enabled with jumpers across pins 1-2 and 5—6 on header JP1, as shown in
Figure 12.

Factory
Default

Figure 12. RS-485 Termination and Bias Resistors

For best performance, the bias and termination resistors in a multidrop network should
only be enabled on both end nodes of the network. Disable the termination and bias resis-
tors on any intervening OP6800 units in the network by removing both jumpers from
header JP1.

TIP: Save the jumpers for possible future use by “parking” them across pins 1-3 and 4-6
of header JP1. Pins 3 and 4 are not otherwise connected to the OP6800.
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3.3.3 Programming Port

The OP6800 programming port is accessed using header J1 on the OP6800’s RabbitCore
module or through the Ethernet jack. The programming port uses the Rabbit 2000’s Serial
Port A for communication. Dynamic C uses the programming port to download and debug
programs.

The programming port is also used for the following operations.
e (Cold-boot the Rabbit 2000 on the OP6800 after a reset.

e Remotely download and debug a program over an Ethernet connection using the
RabbitLink EG2110.

e Fast copy designated portions of flash memory from one Rabbit-based board (the
master) to another (the slave) using the Rabbit Cloning Board.

Alternate Uses of the Programming Port

All three clocked Serial Port A signals are available as

e a synchronous serial port

¢ an asynchronous serial port, with the clock line usable as a general CMOS input

The programming port may also be used as a serial port via the DIAG connector on the
programming cable.

In addition to Serial Port A, the Rabbit 2000 startup-mode (SMODEQ, SMODEI1), status,
and reset pins are available on the programming port header.

The two startup mode pins determine what happens after a reset—the Rabbit 2000 is
either cold-booted or the program begins executing at address 0x0000.

The status pin is used by Dynamic C to determine whether a Rabbit microprocessor is
present. The status output has three different programmable functions:

1. It can be driven low on the first op code fetch cycle.
2. It can be driven low during an interrupt acknowledge cycle.
3. It can also serve as a general-purpose output.

The /RESET_IN pin is an external input that is used to reset the Rabbit 2000 and the
OP6800 onboard peripheral circuits.

Refer to the Rabbit 2000 Microprocessor User’s Manual for more information.
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